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Introduction

Welcome to the Introduction to the Work Coordinate System (WCS) tutorial. Before 
you begin the lessons, it is recommended you first complete the Introduction to 
Mastercam tutorial, which gives an introduction to Mastercam’s views and planes.

Tutorial Goals
 Learn about views and planes, specifically WCS.
 Understand the difference between tool planes (Tplanes) and WCS.
 Machine two parts on different fixtures using one setup.
 Create and change the WCS for previously created toolpaths.

Estimated time to complete this tutorial: 4 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
 The tutorials cannot be used with Mastercam Demo/Home Learning Edition 

(HLE). The Demo/HLE file format (emcam) is different from the Mastercam file 
format (mcam), and basic Mastercam functions, such as file conversions and 
posting, are unavailable.

 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills. 
We recommend that you complete them in order. 

 Additional files may accompany a tutorial. Unless the tutorial provides specific 
instructions on where to place these files, store them in a folder that can be 
accessed from the Mastercam workstation, either with the tutorial or in any 
location that you prefer.

 You will need an internet connection to view videos that are referenced in the 
tutorials. All videos can be found on our YouTube channel: 
www.youtube.com/user/MastercamTechDocs.

 All Mastercam tutorials require you to configure Mastercam to work in a 
default metric or English configuration. The tutorial provides instructions for 
loading the appropriate configuration file.
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Working With Views and Planes

Mastercam uses a 3D Cartesian coordinate system to locate your work in three-dimen-
sional space. This means that geometry and toolpath positions are expressed in terms 
of three coordinate axes: X, Y, and Z. Each axis is signed, which means it has a positive 
and negative direction.

The focus of this tutorial is the Work Coordinate System, or WCS. The WCS refers to 
the alignment of the coordinate system itself. You can choose to align the coordinate 
system axes with any view you wish. 
When you create a new WCS the following happens:

 You map the XY plane to the plane of the view. 
 The origin of the view becomes your new (0,0,0) point. 
 The plane becomes the Top plane in the new working coordinate system. 
 Gviews, Cplanes, and Tplanes are all measured relative to the WCS and its 

origin.
Views and planes are used frequently in Mastercam for many drawing and machining 
purposes. However, you select a new WCS much less often, and only for specific 
machining purposes. 

Views and Planes
This section introduces ways to access and use planes. You use planes for three main 
functions.

 Graphic views (Gviews) - A Gview determines the angle from which you look 
at your part in the graphics window.

 Construction planes (Cplanes) - When you draw geometry, the Cplane is 
where geometry is created. This doesn’t have to be the same as the Gview. For 
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example, you can look at your part in Isometric Gview, while drawing 
geometry in the Front Cplane. 

 Tool planes (Tplanes) - This plane is typically normal to the tool axis. Tplanes 
are only used when creating toolpaths. They determine the tool orientation. In 
most cases, your Cplane is the same as your Tplane (the most common 
exceptions are Mill/Turn operations).

In addition, you can create a new WCS by mapping the entire coordinate system to a 
different plane.
Most of the tools for working with planes are 
located in the Planes Manager on the left 
side of Mastercam’s window. To view the 
Planes Manager, click the Planes tab at the 
bottom of the window. The picture to the 
right shows the Planes Manager.

Mastercam displays the current CPlane, 
Tplane, and WCS in the Status Bar.
Mastercam displays the current Gview in the 
bottom-left corner of the graphics window. 
You can set the Gview from the View ribbon, 
from the graphics window’s right-click menu, 
or from the Planes Manager.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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In this tutorial’s first lesson, you create a toolpath to machine a part in two ways, one 
using a Tplane and one by changing the WCS. 
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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LESSON 1
1Changing the TPlane vs Changing the 
WCS 

In this lesson, you create a Dynamic toolpath to cut the slanted slot face of the part. 
You create toolpaths to machine it in two ways:

 First, you machine the part as if it were mounted on a table. You use a 
machine with rotary axis capability so that the tool axis is rotated to the 
proper orientation. To do this, you select a Tplane aligned with the slanted 
face. 

 Second, you machine the part as if it were mounted in a fixture. You create a 
toolpath that machines the part as if it were lying flat, without moving or 
transforming geometry. To do this, you change the WCS so that it aligns with 
the slanted faces of the part.

Lesson Goals
 Create a Dynamic Contour toolpath with the selected Tplane.
 Change the WCS on the Dynamic Contour toolpath.
 Review both NC files to see rotary position commands.

Exercise 1: Selecting the TPlane
The Tplane determines the orientation of the XY plane in which the toolpath is calcu-
lated. In a simple 3-axis toolpath, the tool axis is typically normal to the Tplane. To set 
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the Tplane, you must align it with a view. You must also keep in mind the following 
when setting a view:

 The XY plane of your toolpath is parallel to the selected view.
 The origin of the selected view determines the zero point of your part 

program.
Unless the Tplane is parallel to the default XY plane, selecting a Tplane typically results 
in A- and/or B-axis codes when you post your toolpaths.

NOTE: To post A- and B-axis code results, your machine definition must 
be configured with the proper rotary axis components, and your post 
must be properly configured for rotary output.

In this exercise, you align the Tplane with the slanted face of the part. 
1 Start Mastercam using your 

preferred method:
 Double-click Mastercam’s 

desktop icon.
Or

 Launch Mastercam from the 
Windows Start menu.

2 Select the default metric configuration file:
a Click the File tab.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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b Choose Configuration from 
Mastercam’s Backstage View to 
open the System Configuration 
dialog box.

c Choose ...\mcamxm.config <Metric> from the Current drop-down list.

d Click OK.
3 Open the part file, BRACE W-VIEW, which was provided with the tutorial. 

4 If necessary, fit the geometry to the screen using [Alt+F1].
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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5 Click the Planes tab in the lower-left 
of Mastercam’s window. (If you do 
not see the Planes tab, activate it 
from the Managers function group 
in Mastercam’s View ribbon.)
The Planes Manager displays.

6 In the row for the FACE OF PART 
plane, click in the C column.

Due to the Tplane follows Cplane 
rule, Mastercam sets both the 
Cplane and Tplane to the FACE OF 
PART plane, which contains the 
slanted slot.

7 Choose File, Save As, and save the part file under a different file name. This 
protects the original tutorial file from being overwritten.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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Exercise 2: Cutting the Slot
In this exercise, you create a Dynamic Contour toolpath to cut out the slot in the face 
of the part.

1 Select Dynamic Contour from the 
2D gallery on the Toolpaths tab. 

2 Click OK if prompted to enter a new 
NC file name.
The Chain Options dialog box 
displays.

3 Click Select under Machining 
regions.
The Chaining dialog box displays.

4 Chain the contour shown to the 
right. The chaining arrow should 
point counterclockwise. 
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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5 Click OK in the Chaining dialog box and in the Chain Options dialog box. 
The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

6 Select the Tool page.

7 Select the 10mm bullnose endmill 
showing in the tool list.

8 Select the Cut Parameters page.

9 Verify that the settings match what 
is shown to the right.

10 Select the Linking Parameters 
page.

11 Set the following parameters:
 Enter 8.0 for Retract.
 Enter 2.0 for Feed plane.
 Enter 0.0 for Top of stock.
 Enter -9.0 for Depth.
 Set all parameters except Top 

of stock to Incremental.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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12 Click OK to generate the Dynamic Contour toolpath.

13 Save your file.

Exercise 3: Backplotting the Toolpath
In this exercise, you backplot the toolpath to see how the tool is oriented relative to 
the part.

1 In the lower-left of Mastercam’s window, click the Toolpaths tab.
The Toolpaths Manager displays.

2 Select the 2D Dynamic Contour 
Mill toolpath in the Toolpaths 
Manager.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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3 Click Backplot selected operations 
in the Toolpaths Manager.
The Backplot dialog box displays.

4 If necessary, select Display tool and 
Display holder.

5 Click Play to see the tool machine 
the toolpath.

The tool is rotated to stay normal to the slanted face of the part. The face 
defines the Tplane FACE OF PART.

6 Click OK in the Backplot dialog box when you have finished reviewing the tool 
motion.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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Exercise 4: Reviewing the NC Code
Since the Tplane (and the tool axis) is tilted about the X axis, you should see an A-axis 
rotation code when you post this toolpath.

1 Select the 2D Dynamic Contour 
Mill toolpath in the Toolpaths 
Manager, and click Post selected 
operations.
The Post processing dialog box 
displays.

2 Set the options as shown, and click 
OK.

3 Click Save if prompted to save the NC file. Mastercam Code Expert opens.
4 Review the NC code when it 

appears.
You should see the A-axis rotation 
code before the tool plunges into 
the part.

5 Close Mastercam Code Expert.

Exercise 5: Changing the WCS to Machine the Slot Lying Flat
In this exercise, you machine the slot using a different approach, as if it were lying flat. 
Instead of rotating the tool, you rotate the coordinate system so that it is parallel with 
the desired face of the part. To do this, you align the WCS with the FACE OF PART 
plane.
In this example, the part is fixtured so that you can cut it on a 3-axis mill that does not 
have a rotary axis. Moving the coordinate system so that it aligns with the selected 
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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part geometry means that you do not have to transform the part. This is often easier 
and more efficient.

1 Right-click in the graphics window, 
and select Right (WCS).

The view changes to the right side of the WCS. Note the gnomon and part 
orientation in the graphics window.

2 Display the Planes Manager.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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3 In the FACE OF PART row, click in the 
WCS column.
The WCS is now aligned with the 
Tplane and Cplane.

4 Right-click in the graphics window, and select Right (WCS).
You can see that the part looks like it has been rotated. When you look at the 
gnomon in the lower-left corner, however, you can see that the axes have 
been rotated, not the part.

Exercise 6: Using the New WCS for a Toolpath
Normally, to create the new toolpath, you would follow the same steps as for the 
previous toolpath. For this exercise, however, you edit the existing toolpath to use the 
new WCS and compare the results.

1 Right-click in the graphics window, 
and select Isometric (WCS).
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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2 In the Toolpaths Manager, click 
Parameters under the 2D Dynamic 
Contour Mill toolpath.

3 Select the Planes (WCS) page.

4 Click the Select WCS plane button 
in the Working coordinate system 
section.
The Plane Selection dialog box 
displays.

5 Select FACE OF PART, and click OK 
to return to the 2D High Speed 
Toolpath - Dynamic Contour dialog 
box.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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6 Verify that your Planes (WCS) page matches what is shown below: 

If your Planes (WCS) page looks different from what is shown here, make sure 
that the Display plane info relative to the WCS option is off. You can find 
this option in the Planes Manager’s Display options, as shown in the picture 
below.

7 Click OK to accept the parameter changes.
8 Click Regenerate all dirty 

operations in the Toolpaths 
Manager.

9 Backplot this toolpath like the previous one.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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You can see that the tool axis is not rotated at all. This means that the part is 
lying flat when machined, so the tool does not need to rotate around to 
machine the slanted face.

Exercise 7: Reviewing the NC Code
After posting this toolpath, you should find no rotary output in your NC Code.

1 Select the Dynamic Contour 
toolpath in the Toolpaths Manager 
and click Post selected operations.
The Post processing dialog box 
displays.

2 Set the options as shown and click 
OK.

3 If prompted, click Save to save the NC file. 
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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4 If prompted to overwrite an existing file, click Yes. Mastercam Code Expert 
opens.

5 Review the NC code when it 
appears.
You should see no A-axis rotation 
code.

NOTE: A0 only appears because you posted this toolpath with the same 
post used in the previous toolpath. Because you used the WCS to elimi-
nate rotary output, you could safely use a 3-axis post and machine defi-
nition.

You have now successfully changed the Tplane and the WCS of a toolpath. In the next 
lesson, you machine two parts on different fixtures. 
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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LESSON 2
2Machining Two Parts on Different 
Fixtures

In this lesson, you machine two parts with the same NC file on two different fixtures. 
Each part is mounted on a different vise on your table.
To machine the parts, you assign a different work offset to each vise. Then, create two 
different toolpaths and include the offset number in each. By basing each toolpath on 
an offset number of a coordinate position, your operator can run the job without 
knowing how the vises are positioned. All they need to do is touch off the parts prop-
erly before running the job to set each position in the control.

Lesson Goals
 Create a new plane for each vise and define its origin.
 Create a toolpath for each created plane.
 Review both NC files to see the correct offset codes.

Exercise 1: Creating the First Plane
Since both parts will be machined in the top plane, you create the new planes by 
copying the system Top plane. You then change the origin and work offset for each 
new plane.

1 Open the part file, Multiple-Fixtures, which was provided with the tutorial. 
2 If necessary, fit the geometry to the screen using [Alt+F1].
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3 Select the Planes tab to view the 
Planes Manager.
The Planes Manager displays.

4 Right-click Top, and select 
Duplicate.
Mastercam creates a plane, Top-1, 
and automatically selects it.

5 Select the Manual work offset 
option, and enter 3 for the Work 
Offset.
You have now set work offset 3, 
which indicates a Gcode 57 for this 
machine. A work offset number is 
used to tell the machine the part’s 
location on the fixture in relation to 
the machine origin.

6 Enter Offset for fixture 1 in the 
Comment area.

7 Double-click Top-1, and rename the 
plane to G57 PLANE.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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8 Click the Select button to the right 
of the origin coordinates to return to 
the graphics window.

9 Select the point on the right side of the left vise.

Exercise 2: Creating the Second Plane
You now repeat the previous process for the second vise.

1 Right-click Top, and select 
Duplicate.

2 Select Manual, and enter 4 for the Work Offset.
3 Enter Offset for fixture 2 in the Comment area.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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4 Rename the plane to G58 PLANE.
You will use this plane for the vise 
on the right side of the table.

5 Click the Select button to the right of the origin coordinates.
6 Select the point on the right side of the right vise.

7 Choose File, Save As, and save the part file under a different file name. This 
protects the original tutorial file from being overwritten.

Exercise 3: Using the First Plane
In this exercise, you set the Tplane to the G57 PLANE to set the part zero and work 
offset to the values you associated with the plane when you created it.

1 In Planes Manager, set the Cplane 
to G57 PLANE.
The Tplane setting follows.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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2 Press [F9] to display the new Tplane/Cplane axes in blue.

NOTE: The fixture table has been hidden to make the axes easier to see. 

3 Press [F9] again to hide the axes.

Exercise 4: Creating the First Toolpath
In this exercise, you create a Dynamic Mill toolpath for the part in the G57 vise.

1 Select Dynamic Mill from the 2D 
gallery in the Toolpaths tab.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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2 Click OK to confirm the default NC 
filename.
The Chain Options dialog box 
displays.

3 Click Select under Machining 
regions.
The Chaining dialog box displays.

4 Chain the contour at the top of the pocket in the G57 vise. Chain direction 
does not matter for this operation.

5 Click OK in the Chaining dialog box and in the Chain Options dialog box. 
The 2D High Speed Toolpaths - Dynamic Mill dialog box displays.

6 Select the Tool page.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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7 Select the 10mm flat endmill 
showing in the tool list.

8 Enter G57 - vise #1 in the Comment 
box.

9 Select the Cut Parameters page.

10 Enter 75.0 for the Stepover 
percentage.

11 Select the Depth Cuts page.

12 Select the Depth cuts checkbox to 
enable the page, and set the 
following parameters:
 Enter 1 for # Finish cuts.
 Enter 2.5 for Finish step.

13 Select the Entry Motion page.

14 Enter 1.0 for the Z clearance.

15 Select the Linking Parameters 
page.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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16 Enter the following parameters:
 Enter 10.0 for Retract.
 Enter 2.0 for Feed plane.
 Enter 0.0 for Top of stock.
 Enter -12.0 for Depth.
 Set all parameters to 

Incremental.

17 Click OK to generate the toolpath.

18 Save your file.

Exercise 5: Using the Second Plane to Create a Toolpath
In this exercise, you set the Tplane to G58 PLANE, and create a Dynamic Contour tool-
path on the second vise.

1 In the Planes Manager, set the 
Cplane to G58 PLANE.
The Tplane follows.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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2 Press [F9] to display the new Tplane/Cplane axes in blue.

NOTE: The fixture table has been hidden to make the axes easier to see.

3 Press [F9] again to hide the axes.
4 Select Dynamic Contour from the 

2D gallery in the Toolpaths tab.
The Chain Options dialog box 
displays.

5 Click Select under Machining 
regions.
The Chaining dialog box displays.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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6 Chain the contour at the top of the pocket in the G58 vise. The chain direction 
should be clockwise for this operation.

7 Click OK to close to Chaining dialog box and again in the Chain Options 
dialog box. 
The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

8 Select the Tool page.

9 Select the 6mm flat endmill 
showing in the tool list.

10 Enter G58 - vise #2 in the Comment 
box.

11 Select the Linking Parameters 
page.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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12 Enter the following parameters:
 Enter 10.0 for Retract.
 Enter 2.0 for Feed plane.
 Enter 0.0 for Top of stock.
 Enter -9.0 for Depth.
 Set all parameters to 

Incremental.

13 Click OK to generate the toolpath.

14 Save your file.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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Exercise 6: Reviewing the NC Code
In this exercise, you post and review the NC code for both toolpaths.

1 In the Toolpaths Manager, click 
Toolpath Group 1 to select all 
operations.

2 Click the Post selected operations 
button on the Toolpaths Manager.
The Post processing dialog box 
displays.

3 Set the options as shown, and click 
OK.

4 Click Save if prompted to save the NC file. Mastercam Code Expert opens.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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5 Review the NC code when it displays. (Use the line numbers in the picture 
below to find the code.) 

For each operation, Mastercam has reset the part zero (0,0,0) and output the proper 
work offset.
In the next lesson, you rotate and position a part and update previously created tool-
paths with a new WCS.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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LESSON 3
3Updating Previously Created Toolpaths

In this lesson, you rotate a part and create two new WCS planes. You then update each 
toolpath with one of the new WCS planes.
The part must be rotated, because the machine it was meant to be cut on is unavail-
able. To cut the part on a different machine, the toolpaths must also be reoriented. 
You can do this by utilizing the WCS, allowing you to continue producing parts with an 
available machine. 

Lesson Goals
 Rotate the part and place it on the fixture.
 Create two new WCS planes for the toolpaths. 
 Update each toolpath to use the new WCS planes. 

Exercise 1: Rotating the Part
In this exercise, you rotate the part so that it is on the same angle as the fixture. 

1 Open the part file, Heart-lock, that was provided with this tutorial.
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2 Fit the geometry to the screen using [Alt+F1], if necessary.

3 In the Toolpaths Manager, select the 
Contour (Ramp) toolpath. 

4 The graphics window now displays the Contour (Ramp) toolpath. Notice how 
the toolpath looks.

5 Display the toolpath motion for the Dynamic Mill toolpath and the Contour 
(2D) toolpath. When you finish viewing the toolpaths, turn them all off.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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6 From the Transform tab, select 
Dynamic.
The Dynamic function panel 
displays.

7 Window select the solid body and wireframe and press [Enter]. (You can also 
press [Ctrl+A] followed by [Enter] to select everything.) The Dynamic Gnomon 
displays.

8 Select the midpoint of the upper arc as the gnomon origin position. 
You may need to zoom in to find the correct position. Keep an eye on the 
mouse cursor, which becomes the midpoint autocursor symbol (shown 
below) when you are in the correct place.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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9 Select the top segment of the curved control for 3D rotation.

10 Type 10.0 and press [Enter].

11 Press [Enter] again to accept the changes. Click OK in the Dynamic Xform 
function panel.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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The part has now been rotated 10 degrees around the X axis.

TIP: Select the Clear Colors button to 
remove group and result colors from affected 
entities. To find this button, right-click in the 
graphics window.

12 Click Regenerate all dirty operations.
13 Choose File, Save As, and save the part file under a different file name. This 

protects the original tutorial file from being overwritten. (You can also access 
the Save functions from the Quick Access Toolbar in the upper-left of 
Mastercam’s window.)

Exercise 2: Placing the Part on the Fixture
In this exercise, you place the rotated part onto the fixture. 

1 Click the Levels tab in the lower-left 
of Mastercam’s window.
The Levels Manager displays.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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2 In the Levels Manager, select the 
Visible column for level 10. 
The graphics window will now 
display the Fixture level. Fit to 
screen, if necessary.

3 From the Transform tab, select Translate.
4 Window select the solid body and wireframe, and then press [Enter]. (You can 

also finalize your selection by clicking the End Selection button at the top of 
the graphics window.)
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)
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The Translate dialog box displays.
5 Set the Translate option to Move.

6 Click the Select FROM Point button 
to return to the graphics window.
You will now select the point to 
translate from. 

7 In the Planes Manager, change the Gview to Bottom.
This view helps to select the point from which to translate.

8 Select the circle center point indicated below on the solid part. Be sure that 
you select the center point of the circle on the bottom of the part.

9 Right-click in the graphics window, 
and select Isometric (WCS). This 
rotates your view back to Isometric.

10 Select the circle center point indicated in the following picture. Be sure that 
you select the center point of the circle on the top of the fixture. As you move 
the mouse, watch for the center point autocursor symbol shown.
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11 Click OK in the Translate dialog box to exit the dialog box and move the part 
onto the fixture.

Notice in the Toolpaths Manager that, after moving the solid body and 
geometry, the toolpaths are marked dirty.
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12 In the Toolpaths Manager, click the 
Regenerate all dirty operations 
button.

13 Select the Lock Body toolpath 
group.

14 Click the Toggle display on 
selected operations button.

15 Notice where the toolpaths are located. 

The toolpaths are no longer dirty, but they are not machining the part 
correctly. 

16 Click the Toggle display on selected operations button again to hide the 
toolpaths.
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17 Save your file.

Exercise 3: Creating New WCS Planes
In this exercise, you create two new WCS planes corresponding to the geometry to be 
machined, one plane for the Contour (Ramp) toolpath and one plane for both the 
Dynamic Mill and Contour (2D) toolpath.

1 Click the Levels tab in the lower-left 
of Mastercam’s window.
The Levels Manager displays.

2 In the Levels Manager, click in the 
Number column for level 3 to 
change it to the main level. 

 3 Turn off (click) the Visible column 
for levels 10 and 1. 
The graphics window no longer 
displays the Fixture level or the Lock 
Back level.

You now create a WCS plane for the Contour (Ramp) toolpath.
4 Click the Planes tab.

The Planes Manager displays.
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5 In the Planes Manager toolbar, 
select Create a new plane, From 
geometry.

6 Select the arc shown below. The Select plane dialog box displays, along with 
the XYZ Gnomon.

7 Cycle through the potential planes 
until the one shown in the image is 
displayed, and click OK.
The New Plane dialog box displays.
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8 Enter Ramp for the plane name.

9 Click OK to close the New Plane dialog box and create the new plane.
Now you create the plane for the Dynamic Mill and Contour (2D) toolpath.

10 Select Create a new plane, From 
geometry from the toolbar.

11 Select the lines shown below, in the order they are numbered. The Select 
plane dialog box displays, along with the XYZ Gnomon.
You may need to zoom in to select the second line.
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12 Cycle through the potential planes 
until the one shown in the image is 
displayed, and click OK.
The New Plane dialog box displays.

13 Enter 2D Mill for the plane name.

14 Click OK to close the New Plane dialog box and create the new plane.

Exercise 4: Updating the Contour (Ramp) Toolpath
In this exercise, you update the three toolpaths to use the WCS planes created in the 
previous exercise. 

1 Select the Levels tab.
The Levels Manager displays.

2 Select the Visible column for level 1. 

3 Click the Toolpaths tab, and select 
Parameters under the Contour 
(Ramp) toolpath.
The 2D Toolpaths - Contour dialog 
box displays.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)



54  MASTERCAM 2017 / Updating Previously Created Toolpaths
4 Select the Planes (WCS) page.

5 Click the Select WCS plane button 
under the Working coordinate 
system group.
The Plane Selection dialog box 
displays.

6 Select Ramp from the plane list.

7 Click OK.
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8 Click the Copy to tool plane and Copy to construction plane buttons, 
shown below. 

By setting the Tool plane and Comp/construction plane to the WCS, you will 
see tool motion commands dimensioned from the part origin, as if it were 
lying flat. 

9 Click OK to save your changes and exit the 2D Toolpaths - Contour dialog 
box.

10 In the Toolpaths Manager, click the 
Regenerate all dirty operations 
button.
This regenerates the Contour 
toolpath.

11 If necessary, select the Contour 
(Ramp) toolpath. 

12 With the toolpath selected, click the 
Toggle display on selected 
operations button.
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13 Notice how the toolpath is now correctly machining the part. 

14 Click the Toggle display on selected operations button again to hide the 
toolpath.

15 Save your file.

Exercise 5: Updating the Dynamic Mill Toolpath
1 In the Toolpaths Manager, select 

Parameters under the 2D High 
Speed (2D Dynamic Mill) toolpath.
The 2D High Speed Toolpath - 
Dynamic Mill dialog box displays.

2 Select the Planes (WCS) page.
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3 Click the Select WCS plane button 
under the Working coordinate 
system group.
The Plane Selection dialog box 
displays.

4 Select 2D Mill from the plane list, 
and click OK.

5 Click the Copy to tool plane and Copy to construction plane buttons. 
6 Click OK to save your changes and exit the 2D High Speed Toolpath - 

Dynamic Mill dialog box.
7 In the Toolpaths Manager, click the 

Regenerate all dirty operations 
button.
This regenerates the Dynamic Mill 
toolpath.

8 If necessary, select the 2D Dynamic 
Mill toolpath. 
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9 With the toolpath selected, click the 
Toggle display on selected 
operations button.

10 Notice how the toolpath is now correctly machining the part.

11 Click the Toggle display on selected operations button again to hide the 
toolpath.

12 Save your file.

Exercise 6: Updating the Contour (2D) Toolpath
Now you assign the second plane to the Contour (2D) toolpath.

1 In the Toolpaths Manager, select 
Parameters under the Contour (2D) 
toolpath.
The 2D Toolpaths - Contour dialog 
box displays.

2 Select the Planes (WCS) page.
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3 Click the Select WCS plane button 
under the Working coordinate 
system group.
The Plane Selection dialog box 
displays.

4 Select 2D Mill from the plane list, 
and click OK.

5 Click the Copy to tool plane and Copy to construction plane buttons.
6 Click OK to save your changes and exit the 2D Toolpaths - Contour dialog 

box.
7 In the Toolpaths Manager, click the 

Regenerate all dirty operations 
button.

8 If necessary, select the Contour 
(2D) toolpath. 
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9 With the toolpath selected, click the 
Toggle display on selected 
operations button.

10 Notice how the toolpath is now correctly machining the part. 

11 Click the Toggle display on selected operations button again to hide the 
toolpath.

12 Save your file.

Exercise 7: Backplotting the Toolpaths
In this exercise, you backplot the toolpaths to see the tool motion.

1 Select the Lock Body toolpath 
group in the Toolpaths Manager to 
select all of the toolpaths.
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2 Click Backplot selected operations 
in the Toolpaths Manager.

3 Click Play in the backplot controls to see the tool machine the toolpath.
The tool axis does not rotate.

4 Click OK in the Backplot dialog box when you have finished reviewing the tool 
motion. 

5 Save your file.

Conclusion
Congratulations! You have completed the Introduction to the Work Coordinate 
System (WCS) tutorial. Now that you have mastered the skills in this tutorial, explore 
Mastercam’s other features and functions. 
You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. Visit our 
website, or select Help, Tutorials from the File tab to see the latest publications.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:
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 Mastercam Help—Access Mastercam Help by selecting Help, Contents from 
Mastercam’s File tab or by pressing [Alt+H] on your keyboard. Also, most 
dialog boxes, function panels, and ribbon bars feature a Help button that 
opens Mastercam Help directly to related information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.

 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. Visit our website, or select Tutorials from the Help menu to 
see the latest publications.

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 
Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 
To register, select Community, Link Account from the File tab, and follow 
the instructions.
INTRODUCTION TO THE WORK COORDINATE SYSTEM (WCS)

mailto:support@mastercam.com
http://www.mastercamu.com
mailto:training@mastercam.com
http://www.mastercam.com
http://www.facebook.com/mastercam
http://www.twitter.com/mastercam
http://www.youtube.com/user/MastercamCadCam
http://www.youtube.com/user/MastercamCadCam
http://forum.mastercam.com
http://kb.mastercam.com
http://www.facebook.com/mastercam
http://www.twitter.com/mastercam
http://www.youtube.com/user/MastercamCadCam
http://google.com/+mastercam
http://forum.mastercam.com
http://www.mastercamu.com


MASTERCAM DOCUMENTATION   63
Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide
 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.
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Attention! Updates may be available. 
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